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Introduction 

In this class we will discuss workflows for structural steel analysis. The applications we will be 
working with are: 

 Autodesk AutoCAD Plant 3D 

 Revit Structure 

 Robot Structural Analysis Professional 

 Advance Steel 

 Navisworks Manage 

We’ll start off with an overview of these applications then move into interoperability of steel 
models between them. Next we’ll go into Robot Structural Analysis and learn about running 
analysis on the steel design. For example, self-load, usage loads, and climatic loads. Finally 
we’ll show how Navisworks Manage can be used to bring the models together from separate 
disciplines and how to perform clash detection. 

Everything is about workflows; initially the concept for this class started as an internal project to 
understand all the possible workflows available for a Plant Designer using Plant 3D and 
collaborating with a structural Designer / Engineer who is familiar with Autodesk Products. 
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Overview of Structural Applications 

 

Advance Steel 

Advance Steel is a CAD software 
application for 3D modeling and detailing of 
steel structures and automatic creation of 
fabrication drawings, bill of materials and 
NC files. With the Advance Steel Plug-in, 
Revit users can quickly connect their models 
to Advance Steel using the export, import, 
and synchronize features to transfer the 
model BIM data.  

For more details about Advance Steel, please visit:   

http://www.autodesk.com/advancesteel 

Autodesk Advance Steel in 3 Minutes 

Robot Structural Analysis (RSA) 

RSA is structural analysis software based on the Finite Elements Method (FEM), 
providing a country-specific analysis and a wide collection of design codes for 
structural engineers. Many types of structures could be analyzed by RSA: 
buildings, bridges, tanks, silos, etc. 

 
For more details, please visit:  www.autodesk.com/robot 

http://www.autodesk.com/advancesteel
https://www.youtube.com/watch?v=wxTt6bwk3m0&list=UU605NHqEkxXsFYdoPrD6mOg
http://www.autodesk.com/robot
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Revit®  

The Revit platform for building information modeling (BIM) is a design and 
documentation system that supports the design, drawings, and schedules 
required for a building project. 

In the Revit model, every drawing sheet, 2D and 3D view, and schedule is a 
presentation of information from the same underlying building model database.  

For more details, please visit:  http://www.autodesk.com/revit 

To get started with Revit: http://knowledge.autodesk.com/support/revit-products/getting-started 

 

Revit Extensions 

Revit Extensions (REX) are the must have tools for Revit Productivity, It provides 
more capabilities to your Revit software, the most useful extensions are: 

 Timber Framing Extension 

 Compare Models 

 Grids Generator 

 Civil Structures 

 CIS/2 Import/Export 

 Excel based model generation 

 Frame Generator 

 Composite Design 

 SDNF Import/Export (this extension is required for this class) 

 

The following article will help you to find and download the REX: 

http://knowledge.autodesk.com/search-result/caas/sfdcarticles/sfdcarticles/How-to-find-and-
download-Autodesk-Revit-Extensions.html 

http://www.autodesk.com/revit
http://knowledge.autodesk.com/support/revit-products/getting-started
http://knowledge.autodesk.com/search-result/caas/sfdcarticles/sfdcarticles/How-to-find-and-download-Autodesk-Revit-Extensions.html
http://knowledge.autodesk.com/search-result/caas/sfdcarticles/sfdcarticles/How-to-find-and-download-Autodesk-Revit-Extensions.html
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AutoCAD Plant 3D 
 
Autodesk® Plant Design Suite 2015 provides comprehensive plant design, 
modeling, and review software. AutoCAD Plant 3D allows users to easily design 
pipe, equipment, and steel models and generate isometric and orthographic 
deliverables. AutoCAD Plant 3D also includes AutoCAD P&ID which is a design 
package for process and instrumentation diagrams. 

Since Plant 3D is built on top of AutoCAD you can use the same commands you 
are familiar with in addition to commands that are designed to operate on Plant 
3D objects. AutoCAD Plant 3D comes with AutoCAD P&ID functionality built-in. 
You can create and edit P&ID drawings within the P&ID workspaces in Plant 3D. 

Plant 3D allows you to: 

 Create and modify spec sheets and catalogs 

 Create and edit P&ID drawings 

 Perform pipe routing 

 Design and place equipment 

 Model preliminary structural steel 

 Generate isometric drawings with automatic annotations 

 Generate 2D orthographic drawings with annotations and customized bill of material 

 Generate customized project reports 

 Export and import data to Microsoft Excel spreadsheets 

For more details about AutoCAD Plant 3D, please visit:  

http://www.autodesk.com/products/autocad-plant-3d/overview 

http://www.autodesk.com/products/autocad-plant-3d/overview
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Best practices for model interoperability with Autodesk Advance Steel, 
Revit, and Plant 3D 

In this section we will discuss the best practices for using 3D models between Advance Steel 
and Revit with Plant 3D. 

Exporting steel from Plant 3D to Revit or Advance Steel 

You can select structural objects in a Plant 3D drawing and export them to a Steel Detailing 
Neutral Format (SDNF) file. Structural objects you can export to this format are: 

 Structural members 

 Railings 

 Ladders 

 Stairs 

 Plates 

When you export railings, ladders, and stairs to SDNF they are exploded into individual 
members. Please note: ladder cages are not included in an export. 

Before attempting an export of steel from Plant we recommend consolidating the separate 
structural steel objects into layers. For example, make sure steel members, stairs, ladders, 
grating, etc. are on their own layer. This will help simplify the export as typically only steel 
members will need to be exported from Plant 3D to SDNF. 

1. Click on the Structure tab on the Ribbon Bar 
2. Click SDNF Export button 

 

3. Choose a location for the output file and fill in the information in the SDNF Export 
window 

4. Click the Select Objects button 
5. Use a window to select the objects to be exported (non-structure objects will be filtered 

out) or type in ALL on the command line if you want to export all steel in the drawing 
 

6. Click the Export button 

Please refer to Autodesk Screencast video for an example of this workflow: 

AU2014: SE5099: Exporting Structural Steel from Plant 3D 

https://screencast.autodesk.com/Main/Details/13f99b69-f7de-4853-ae3f-0a5718c71638
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Export / Import for Revit and Advance Steel with Extension (.GTCX) 

Steel models that have been imported into Revit through SDNF or created from within Revit can 
be exported to a .GTCX file and then imported into Advance Steel. This special file is used to 
transfer data between the two applications. This feature requires the use of Advance Steel 
2015.1 Extension available from the Autodesk Exchange Apps Store. 

Export to a .GTCX file from Revit 

1. From the Add-Ins tab on the Ribbon Bar click the Advance Steel Extension button: 

 

2. Select “Export” from the list 

3. Make sure “Advance export” is selected: 

 

4. Click OK button 

5. Specify a location for the exported file 

 
If you do not want beam shortenings from Revit to be exported with the .GTCX 
file, un-check the “Export beam shortenings” checkbox from the Settings for the 
Advance Steel Extension. The settings are available from the drop-down list of 
the Advance Steel Extension on the Add-Ins tab in Revit. 
 

https://apps.exchange.autodesk.com/RVT/en/Detail/Index?id=appstore.exchange.autodesk.com%3aadvancesteel20151extension_windows64%3aen
https://apps.exchange.autodesk.com/RVT/en/Detail/Index?id=appstore.exchange.autodesk.com%3aadvancesteel20151extension_windows64%3aen
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Importing a .GTCX file into Advance Steel 

1. From the Export & Import tab on the Ribbon Bar, select Import on the Revit panel: 

 

2. Browse to the location of the .GTCX file and click the Open button 

3. Map sections as required: 

 
4. The steel members are now imported from Revit and ready to use. 
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Synchronizing .GTCX files between Revit and Advance Steel 

Once a .GTCX file has been exported and imported into the corresponding application, 
synchronization can be used to keep the file up to date. 

Advance Steel Synchronization 

1. Select the Export & Import tab from the Ribbon Bar 
2. Click the Synchronize button from the Revit panel: 

 

 
3. Click the Load button and browse to the .GTCX file and open it 

 

Revit Synchronization 

1. Select the Add-Ins tab from the Ribbon Bar 
2. Click the Advance Steel Extension drop-down button  
3. Select Synchronization: 

 

 
4. Click the Load button and browse to the .GTCX file and open it
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Exporting from Revit Structure to Plant 3D 

After modifications have been made to the model in Revit Structure you can export the Revit 
model to a .DWG file. This drawing can be imported into your Plant 3D project or attached as an 
XREF. This updated model will replace your preliminary steel model that was created inside of 
Plant 3D. 

One recommendation is creating a new “host” or container drawing inside the Plant 3D project 
where the Revit .DWG will be inserted as an XREF.  

This accomplishes three things: 

 The Revit model can be re-exported (overwrite the .DWG file) at any time by the Revit designer 

 Existing Orthographic views in the Plant project using this drawing can easily be updated 

 No need to remove and add the drawing into the project again 

DWG Export Setting in Revit 

The default setting for DWG/DXF export in Revit is Polymesh export for solids. This needs to be 
changed to ACIS solids so the Orthographic views can be properly generated from the exported 
geometry within AutoCAD Plant 3D. 

To change this option inside of Revit: 

1. Click on the Application Button in the upper left-hand corner of the Revit application 

 

2. Go to Export -> Options -> Export Setups DWG/DXF 

3. Click on the Solids tab 

4. Select “ACIS solids”  

5. Click OK 
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Using Advance Steel models with Plant 3D 

3D model drawings from Advance Steel can be used in your Plant 3D project. Just like .DWGs 
exported from Revit, you can either copy them into the project or use a host/container drawing 
to insert the Advance Steel drawing. 

Advance Steel Output Settings 

The default setting for Advance Steel is to save without proxy graphics. This means the DWG 
files will be saved with no proxy objects. This needs to be changed to Save with area Proxy-
Graphics so the Orthographic views can be properly generated within AutoCAD Plant 3D. This 
setting is drawing specific and must be changed on each drawing that is exported. 

Note: If you are using the Advance Steel 2015.1 Object Enabler this setting can be left as 
default. Plant 3D will be able to process the Advance Steel objects for Orthographic view 
generation through the use of the Object Enabler. 

To change this option inside of Advance Steel:  

1. Click on the Output tab 

 

2. Click the button for “Save with area Proxy-Graphics” 

 

 

http://knowledge.autodesk.com/support/advance-steel/downloads/caas/downloads/content/advance-steel-20151-object-enabler.html
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Attaching Advance Steel Drawings to Plant 3D models 

Once you have detailed your steel model in Advance Steel it’s time to bring the updated model 
into Plant 3D. In this example we will create a new drawing in Plant 3D to host the AS model 
and then attach it as an XREF into the Plant 3D pipe and equipment drawing. 

1. Create a new Plant 3D drawing inside the project 

2. Open this drawing and use the XREF command to attach the new AS model  

Note: Make sure the attachment type is set to “Attachment” and not “Overlay 

3. Open the pipe and equipment model where the preliminary steel model was attached 

4. Unload the preliminary steel model XREF 

5. Attach the new drawing with the Advance Steel model into the pipe and equipment 
drawing 

Now with the Advance Steel model in your project any future modifications that are made in 
Advance Steel will carry over when the XREF is reloaded.  
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How to perform structural analysis of steel structures with Robot 
Structural Analysis 

The following chart is illustrating the structural analysis process: 

 

Model definition 

The 3D model could be created from scratch (using Structural Axis import .DXF or .DWG 
background) or imported (from Revit ideally.) 

Creating a new model from scratch  

There are different options to achieve that: 

1. Use the coordinates: 
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2. Use the Structural Axis 

 

3. Import DWG/DXF (other formats are available) file and convert lines to bars: 

 

4. Import DXF/DWG as backgrounds: 
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Import a Revit file  

In Revit, the analytical model is a representation of the structure required for structural 
analysis and design. 

In general, the user may need to prepare the Revit model for structural analysis, by doing 
the following: 

 To prepare analytical views use the analytical model settings tab to specify auto-
detect and consistency check tolerances.  

 Adjust manually the analytical model (click analytical adjust, select an analytical 
element to display its direct manipulation controls). 

 Download and install the Structural Toolkit to enable the integration with RSA and 
RSA360: AU2014:SE5099: Download Structural Toolkit from App exchange 

Send the Revit model to RSA 

In Revit, click Analyze tab  Structural Analysis panel  Robot Structural 
Analysis  Robot Structural Analysis Link 

 

AU2014:SE5099: Exporting a Revit Model to Robot Structural Analysis 

If you created your 3D model from a scratch in RSA you could use the Revit structure Add-in to 
export your RSA model directly to Revit. 

 

https://screencast.autodesk.com/Main/Details/2304a9e9-e9b1-4b50-aab3-12e3e263ef24
https://screencast.autodesk.com/Main/Details/307a1918-d985-4b8c-bb78-bc05b51d0eb4
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The structural engineer may need to run verification and fix errors before proceeding, supports 
in some cases need to be rectified or added. 

 

AU2014:SE5099: Check and add supports to Structural Model in RSA? 

 

https://screencast.autodesk.com/Main/Details/f9d23422-8687-4009-a20c-5012d430bbcd
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Load definition 

Most basic type of loads could be applied within Revit, but RSA offers an extended choice of 
loads and some of them could be generated automatically like Wind, Snow, Seismic (available 
in some codes) 

To apply a load in RSA, a load case needs to be set up first (Loads\ Load Types…) 

So, for instance, Dead, Live, Wind, Snow and Seismic loads were defined below: 

 

Once a load case has been set up it can be applied to structure elements such as nodes, bars, 
or surfaces. 
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Load Definition Setup in RSA 

1. Click Loads   Load Definition. The Load Definition dialog opens. 

2. Go to the tab corresponding to the type of structure element on which the load must be 
applied. 

 

3. Click on the type of load that you want to define. A dialog corresponding to the type of 
load selected opens. 

Specify the necessary values for the load and then 
click Add. The type of load is now displayed under 
the load case name in the Load Definition dialog 
and the cursor changes to a load symbol. 

4. Apply the loads to the structure. 
 
 

AU2014:SE5099: apply a load in RSA 

In Revit within the Analyze tab, Load cases and Loads 
could be defined as well. 

 

 

 

https://screencast.autodesk.com/Main/Details/91138f36-2e97-472b-829d-50c8a2a0e1fc
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Load Definition Setup in Revit 

 

AU2014:SE5099: apply a load in Revit 

 

Analysis 

Many kinds of analysis could be performed such as static-linear, dynamic, non-linear, etc. 
 
To run a static-linear analysis, just hit the calculations button: 
 

 
 
The results could be displayed on Diagrams, Maps and spreadsheets. 
 
For more advanced analysis (dynamic, non-linear…) please refer to the RSA Help or check 
some advanced classes on the Autodesk University web site. 

There is also another alternative (very interesting for large models) to run a static-linear analysis 
using RSA360 (Analyze in Cloud): 

 

https://screencast.autodesk.com/Main/Details/8c124fb0-192e-441d-a872-2994e9b437ed
http://help.autodesk.com/view/RSAPRO/2015/ENU/
http://au.autodesk.com/
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The Load Takedown Extension is also a good option to perform the analysis of load takedown 
for vertical forces and reactions (without using RSA or the cloud.) 

 

If you need to run analysis for a specific beam you could use the Static Analysis of Beams 
extension: 

 

Another interesting Revit Extension is the Static Analysis of Frames which could be used if 
you are interested to run a static analysis of a 2D frame without using RSA or RSA 360. 
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Code checking (steel design) 

The steel design option offers the possibility of a quick and efficient verification of sections used 
in the structure. The user may apply a ready-to-use template containing a layout of dialog boxes 
necessary for design of steel elements. 
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Selection of the Steel Design template makes successive operations aimed at structure 
verification considerably easier: 

 Selection of members to be verified 

 Start of member verification 

 The short results dialog box contains the most significant information about sections 

 

The option of steel verification and design enables a quick and efficient ULS analysis of sections 
used in the structure. 
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Practice 

In the following tutorial you will learn how to model a 3D frame  

 

Step 1: Set preferences 

Step 2: Add sections 

Step 3: Define the structure 

Step 4: Define supports 

Step 5: Copy existing 2D frame 

Step 6: Define load cases 

Step 7: Apply load cases 

Step 8: Generate a manual combination 

Step 9: Run a calculation 

Step 10: Display beam results graphically 

Step 11: Display results on bars in tabular form 

Step 12: Stress Analysis for structure 

Step 13: Definition of code parameters 

Step 14: Define groups of members 

Step 15: Code group design 

Step 16: Code group verification 

http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-81EA7CED-5311-4EDB-AEE6-97C4A758CDF0
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-AFA263C7-BFD3-4ECC-ACAC-EE606039B2C0
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-47249307-4501-4A96-A424-E279CA971089
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-21056D17-6317-4C09-B616-9BB56C5FC1F2
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-B50228C5-2468-4781-8E5F-51802EE6073B
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-6614C5E2-B983-49A7-8193-F9ADF95666F5
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-E296C25D-6961-443F-97B6-EBCA3C5F69F7
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-0D8413E4-7561-42B7-9194-1D248229CCC8
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-E45F82CD-323A-457C-A777-BA7B377E601C
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-E161DB5C-A0E6-48D4-A85C-6FA09AC2A265
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-0A252872-879E-4D6C-81A1-104AFF52A42B
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-E501E70D-6609-48DB-BCF3-2A49865F7514
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-65889C67-A3EC-4BA6-920F-8E4DC6BA4BC2
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-A56AB867-2DE8-431F-A149-ED33C8937DB6
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-CB97819F-A88E-4ACC-8AFA-9E9B80AA5555
http://help.autodesk.com/view/RSAPRO/2015/ENU/?guid=GUID-64805C4A-C7C7-4254-ACB2-230C7416D022
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Collaboration between engineering disciplines with Navisworks 

In this section we discuss the use of Navisworks 
Manage to bring the models together with other 
disciplines. This includes appending the models and 
running clash detection against the steel structures. The 
samples models from the class will be used. 

 

 

 

The first task is appending the models into Navisworks. You can import many different file 
formats directly into Navisworks. In this example we will be appending .DWG files from Plant 3D 
and Advance Steel. 

Make sure you have the proper Object Enabler installed for the application you appending from. 
For example, you would need to have the Plant 3D Object Enabler loaded onto Navisworks 
Manage in order to properly display the Plant specific objects. 

Object Enablers for Autodesk applications can be found on this site:  

Autodesk Knowledge Network: Object Enablers 

Appending models and running a clash detection in Navisworks 

1. Click the Append button on the Home tab of the Ribbon Bar. Select the models you wish 
to include and click the Open button. 
 

 
 

2. Click the Clash Detective button on the Home tab of the Ribbon Bar 

 

 

http://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/ENU/123112/files/autocad-object-enablers-html.html?v=2015
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3. Click the Add Test button from the Clash Detective palette 

 
 
4. Give the test a name and make a selection for A & B 

(Clashes will be tested between Selection A and Selection B) 

 

5. Adjust the settings in the lower section of the Clash Detective window to set the 
tolerance of what will be detected as a clash. For example, we want to check for any 
clearance issues and we want the tolerance to be 1”. Any clashes within the range 
will be reported. 

6. Click the Run Test button 

7. The Clashes will be displayed in the Results section 
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The test results, status of the clashes, and comments can be saved in the Navisworks .NWF 
file. When the drawings change and the .NWF is refreshed the clash test can be re-ran and the 
statues will be maintained for any existing clashes.  

The results can also be exported to an XML file and imported back in at a later time. Also, a 
complete report can be written to XML or HTML format for delivery to a client of design team. 

 

 

Figure 1. Clash Report in HTML format 
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